CHAPTER

Other Network Management Tasks

This chapter provides information on the following:
e Performing Routine Network Management, page 8-1
e Using Cisco MGC Node Manager To Launch Device Configuration, page 8§-4
e Viewing or Modifying Account and SNMP Information, page 8-5
e Viewing Properties for Devices and Their Components, page 8-8, including:
— Viewing Properties for Devices, page 8-9
— Viewing Properties for Interfaces, page 8-14
— Viewing Properties for the Cisco SLT SS7 MTP2 Channel, page 8-18
— Monitoring Cisco MGC Host, HSI Server, and BAMS File Systems, page 8-19
- Viewing System Component Properties, page 8-21
— Viewing Dial Plan Component Properties, page §-22
— Viewing Signaling Component Properties, page 8-27
— Viewing Trunk Group Component Properties, page 8-44
e Using Diagnostic Tools, page 8-51
e Using the Cisco MGC Toolbar, page 8-54

Performing Routine Network Management

This section presents checklists of routine procedures for network management using Cisco MGC Node
Manager. Because Cisco MGC Node Manager is used in many different types of situations, no single
checklist can describe optimal procedures for all cases. The information here is designed to help guide
your thinking about your own management routines, tailored to your particular network and users.

Procedures for Getting Started

Task Steps

Install Cisco EMF and Cisco MGC Node See the Installation Guide.
Manager (system administrator)
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Bl Performing Routine Network Management

Task

Steps

Configure network devices for management
(system administrator)

See Chapter 2, “Configuring Network Devices for
Management”

Set up security (system administrator)

See Chapter 4, “Setting Up Cisco MGC Node
Manager Security”

Deploy the network, creating a model of your
network in Cisco MGC Node Manager

See Chapter 5, “Deploying Your Network in
Cisco MGC Node Manager”

Identify key performance measurements to
monitor

See Chapter 7, “Managing the Performance of
Cisco MGC Node Manager Devices,” “Selecting
'What To Monitor” section on page 7-14

Set up threshold crossing alerts and scoreboards

See Chapter 6, “Managing Faults with Cisco MGC
Node Manager,” “Task 2. Customizing Event
Management” section on page 6-4

Routine Daily Procedures

Task Steps
(Ongoing) Monitor the network for changes in |1. At the top level of the Map Viewer, monitor
status. changes.

2. When you see an alarm, drill down to find
where the problem occurred.

3. Right-click the device object and choose
Tools > Event Browser to view details on the
alarm.

4. Click the Acknowledge button for this event
to indicate that the problem is being
investigated.

See Chapter 6, “Managing Faults with Cisco MGC
Node Manager,” “Using the Event Browser to
Manage Events” section on page 6-9 for details.

After identifying the alarm, use diagnostics to
diagnose the problem. See the “Using Diagnostic
Tools” section on page 8-51.

If the network is not monitored continuously,
look at alarms that came in overnight,
specifically:

e Active alarms

e Alarms that were received and cleared,
including alarms cleared automatically

e Destination in service alarms, such as PRIs
or SS7s

¢ Switchovers from standby to active status

Work from the most severe alarm to the least
severe.

Investigate active alarms as described in the
previous task.

Alternatively, in the Map Viewer, right-click the
Cisco MGC host object and choose Properties,
then click the Software tab. See the “Viewing
Properties for Devices” section on page 8-9 for
details.
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Performing Routine Network Management

Task

Steps

Check the health of the devices assigned to you:
e Are they in service?
e Are they reachable using ping?

e [s the device communicating with
Cisco MGC Node Manager?

If you cannot access a device, in the Map Viewer,
right-click the device object, and choose Tools >
[Device name] Diagnostics. On the General tab,
click IP Ping or SNMP Ping. See the “Using
Diagnostic Tools” section on page 8-51 for details.

Check the amount of disk space available on the
Cisco MGC host. Pay special attention to root
(/) and opt directories.

Monitor the file system. In the Map Viewer,
right-click the Cisco MGC host object and choose
File Systems. See the “Monitoring Cisco MGC
Host, HSI Server, and BAMS File Systems”
section on page 8-19 for details.

Check the amount of virtual memory available
on the Cisco MGC host.

In the Map Viewer, right-click the Cisco MGC host
object and choose Devices > Virtual Memory
Properties. See the “Viewing System Component
Properties” section on page 8-21 for details.

Check the status of trunks.

Check status: In the Map Viewer, right-click the
Trunking folder and choose Properties, then click
the Status tab.

Verify trunk group: In the Map Viewer, right-click
the BAMS and choose Properties, then click the
Status tab.

Check CPU usage on the Cisco MGC host.

In the Map Viewer, right-click the Cisco MGC
host object and choose Devices > Processor
Properties. See the “Viewing System Component
Properties” section on page 8-21 for details.

Check the number of processes running on the
Cisco MGC host. Generally, there should not
be more than 60 to 70 processes running.

To see the number of processes: In the Map
Viewer, right-click the Cisco MGC host object and
choose Properties, then click the Software tab.
The number of processes is displayed at the
bottom of the dialog box. See the “Viewing
Properties for Devices” section on page 8-9 for
details.

To view the status of processes: In the Map Viewer,
right-click the device object and choose Tools >
MGC Host Diagnostics. On the General tab, click
Process Status. See the “Using Diagnostic Tools”
section on page 8-51 for details.

Check the number of users on the Cisco MGC
host.

In the Map Viewer, right-click the Cisco MGC
host object and choose Properties, then click the
Software tab. See the “Viewing Properties for
Devices” section on page 8-9 for details.

Cisco SLTs: Check memory used and RAM.

In the Map Viewer, right-click the Cisco SLT
object, choose Properties, and click the Memory
tab. See the “Viewing Properties for Devices”
section on page 8-9 for details.
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M Using Cisco MGC Node Manager To Launch Device Configuration

Task Steps

For traffic engineering, look at trunk group
measurements to identify when the network is
reaching circuit capacity.

(As needed) Deploy new devices and delete See Chapter 5, “Deploying Your Network in
obsolete devices. Cisco MGC Node Manager,” “” section on
page 5-17

Routine Weekly Procedures

Task For More Information, see

Analyze measurement data for trends: Chapter 7, “Managing the Performance of
Cisco MGC Node Manager Devices,” “Exporting

1. Export desired performance data. . i
Bulk Performance Data” section on page 7-17

2. Import the data into an external
measurement report and analysis tool such
as Trinogy Trend.

Using Cisco MGC Node Manager To Launch Device
Configuration

From Cisco MGC Node Manager, you can launch configuration tools for the Cisco MGC node devices.
Specifically, you can launch:

e The Cisco Voice Services Provisioning Tool (VSPT) to configure the Cisco MGC host

~

Note  The Voice Services Provisioning Tool (VSPT) was formerly known as MNM-PT.

e CiscoView to configure the Cisco SLT and Cisco LAN switch

e Telnet or an X terminal window to use MML, UNIX, and OSI commands. If SSH is enabled on
Cisco MGC Node Manager and the target device, SSH is used instead.

Launching Configuration Tools

You can launch configuration tools for various devices from the Cisco MGC Node Manager Map Viewer,
as shown in Table 8-1.

Table 8-1 Configuration Tools for Cisco MGC Node Devices

Cisco MGC Node Device Available Tools

Cisco MGC host Cisco VSPT or Cisco MGC Manager
Telnet or ssh; MML
BAMS Telnet or ssh; MML
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Step 1
Step 2

Step 3
Step 4

Step 1
Step 2

Step 3
Step 4

Viewing or Modifying Account and SNMP Information

Table 8-1 Configuration Tools for Cisco MGC Node Devices (continued)

Cisco MGC Node Device Available Tools
HSI server Telnet or ssh; MML

Cisco SLT CiscoView
http://www.cisco.com/en/US/products/sw/cscowork/ps4737/prod_tec
hnical_documentation.html

Telnet

Cisco LAN Switch CiscoView
Telnet or ssh

Use the following procedure to launch a configuration tool:

In the Map Viewer, right-click the device you want to configure, and choose Tools.
From the Tools menu, choose one of the following:

¢ Voice Services Provisioning Tool (or for Cisco MGC releases below 7.4.12, Cisco MGC
Manager) to configure the Cisco MGC host

¢ CiscoView to configure the Cisco SLT and Cisco LAN switch
The application opens.

~

Note  The Cisco PGW deployment user ID and password are passed to VSPT and you are logged in
with the privileges assigned to that user, read-write or read-only. If there is no deployment user
ID and password, VSPT opens to the log in window, and you must log in manually.

Perform the desired configuration.

Close the application when you are done.

Use the following procedure to launch a Telnet session (or ssh, if SSH is enabled) or an X terminal
window to use UNIX, OSI, and MML commands:

In the Map Viewer, right-click the desired device, and choose Tools.

From the Tools menu, choose Connection Service.

A Telnet, ssh, or X terminal window opens, and you are connected to the selected device.
Enter MML commands, or perform other desired operations.

Close the window when you are done.

Viewing or Modifying Account and SNMP Information

You can view the account and SNMP information that resides in the Cisco MGC Node Manager database
for any of the following Cisco MGC node devices:

[ oL-9110-01
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Bl Viewing or Modifying Account and SNMP Information

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

e Cisco MGC host

e BAMS

e (Cisco SLT

e (Cisco LAN Switch
e HSI server

Account information and SNMP read and write community strings are defined when a device is
deployed. If the actual device information changes—for example, if a password is changed—you can
modify it to update the Cisco MGC Node Manager database. The changed information is used in device
rediscovery.

Use the following procedure to view or change account or SNMP information in the Cisco MGC Node
Manager database:

From the Map Viewer, select the desired device or devices.

~

Note  Alternatively, if you have a Properties, States, Diagnostics, or File Systems (if applicable) dialog
box open for the device, you can use the dialog box Navigation menu to open the Accounts
dialog box.

Right-click, and choose Accounts.
The Accounts dialog box appears.

If you have selected more than one device, choose the desired device in the list box on the left side of
the dialog box.

Check or change device information. See the “About the Accounts Dialog Box” section on page 8-7 for
details.

If you make changes, click the toolbar Save button, or choose File > Save. The updated information is
saved in the Cisco MGC Node Manager database.

In the Accounts dialog box, you can use the toolbar buttons or menu options to:
e Print the information on the current tab
¢ C(Close the dialog box
e Toggle dynamic update mode off and on
e Refresh the window to update the information when dynamic update mode is off
e Acknowledge that you have seen dynamically-updated changes

You can use the Navigation menu to open the Properties, File Systems (where applicable), States, or
Diagnostics dialog box for the selected component.

~

Note  The status bar shows the current status of the device.

~

Note  If the account is locked (the lock icon is closed), you do not have permission to view this
information.
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Viewing or Modifying Account and SNMP Information

About the Accounts Dialog Box

The Accounts dialog box displays login and SNMP information for the selected network device. This
information is used when the device is rediscovered. The Accounts dialog box contains the Accounts tab
and the SNMP tab.

By default, the Accounts dialog is dynamically updated as device information changes. You can use
toolbar buttons to turn updating on or off, acknowledge that you have seen updated information, and
check for changes when dynamic updating is off.

The Accounts dialog box includes a Navigation menu that allows navigating directly to Properties, File
Systems, States, or Diagnostics dialog boxes for the selected component, without having to reselect the
component in the Map Viewer. See Chapter 3, “Getting Started with Cisco MGC Node Manager,”
“Navigating between Dialog Boxes for a Given Component” on page 32 for details.

The Accounts Dialog Box Toolbar

The Accounts Tab

The SNMP Tab

The toolbar contains buttons for these functions:
¢ Close the current window
¢ Print the contents of the window
¢ Toggle dynamic update mode, to allow viewing or not viewing real-time changes
e Refresh the window, to update the information when dynamic update mode is off
e Acknowledge that you have seen dynamically updated dialog box changes
e Save your changes to the Cisco MGC Node Manager database

Dynamic updates are displayed in blue. When an update occurs, the dialog box moves in front of other
open Cisco MGC Node Manager windows. Click the Acknowledge button to acknowledge you have seen
changes and remove the blue highlighting.

The Accounts tab contains the following fields:
Login ID—The login ID defined in the Cisco MGC Node Manager database.
Password—The password defined in the Cisco MGC Node Manager database.

Root or Enable Password—The root or enable super-user password defined in the Cisco MGC Node
Manager database.

Security Policy—The security protocol used for communication with the device.

e Choose SSH if you have installed the Cisco EMF SSH add-in and the device is SSH-enabled. With
SSH support installed, all operations that previously used Telnet or FTP to communicate with
network elements instead use ssh (the secure shell program, the SSH counterpart of Telnet) and sftp
(secure FTP).

e Choose None for non-secure devices.

The SNMP tab contains the following fields:
Read Community—SNMP read-community string.

Write Community—SNMP write-community string.

[ oL-9110-01
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M Viewing Properties for Devices and Their Components

Timeout (seconds)—The number of milliseconds the system attempts to connect remotely when
performing an SNMP operation before timing out. The default value is 5000.

Retries—The number of times the system attempts to connect when performing an SNMP operation. The
default value is 2.

Varbinds/Packet—The number of varbinds sent in a single packet to an SNMP agent. The default value
is 5.

SNMP Version—The version of SNMP running on this device. Versions 1 and 2 are supported.

Viewing Properties for Devices and Their Components

You can view properties for any of the Cisco MGC node devices and for their major components.

You can view properties for the following devices, as described in the “Viewing Properties for Devices”
section on page 8-9:

e The Cisco MGC host
¢ BAMS

e HSI server

e Cisco SLT

e (Cisco LAN switch

You can view properties for Serial, Ethernet, and TDM interfaces, as described in the “Viewing
Properties for Interfaces” section on page 8-14.

You can view properties and monitor the usage of the Cisco MGC host, HSI server, and BAMS file
systems, as described in the “Monitoring Cisco MGC Host, HSI Server, and BAMS File Systems”
section on page 8§-19.

You can view properties for system components (disk partitions, processor, RAM, and virtual memory)
of the Cisco MGC host, HSI server, and BAMS, as described in the “Viewing System Component
Properties” section on page 8-21.

You can view properties for the following Cisco MGC node components:

e Dial plan components, as described in the “Viewing Dial Plan Component Properties” section on
page 8-22.

e Signaling components, as described in the “Viewing Signaling Component Properties” section on
page 8-27.

¢ Trunking components, as described in the “Viewing Dial Plan Component Properties” section on
page 8-22.

All Properties dialog boxes share the basic functionality described in the next section, “Common
Functionality in Properties Dialog Boxes” section on page 8-8.

Common Functionality in Properties Dialog Boxes

8-8

All Properties dialog boxes display dynamically updated information and provide similar functionality,
with the main functions accessible from a toolbar. If a Properties dialog box is opened for more than one
component, a list box on the left side of the dialog box lists the available components. The Properties
information applies to the selected component.

Cisco Media Gateway Controller Node Manager User's Guide, 2.6(1)
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Note

Viewing Properties for Devices and Their Components [l

Properties dialog boxes include a Navigation menu that allows navigating directly to other dialog boxes
for the selected component, without having to reselect the component in the Map Viewer. See Chapter 3,
“Getting Started with Cisco MGC Node Manager,” “Navigating between Dialog Boxes for a Given
Component” on page 32 for details.

The specific properties you see depend not only on the network element you are inspecting but also on
the release of the Cisco MGC host software that you are using.

The Properties Dialog Box Toolbar

In every Properties dialog box (see Figure 8-1), a toolbar contains buttons for these functions:
* Close the current window
e Print the contents of the window
¢ Toggle dynamic update mode, to allow viewing or not viewing real-time changes
e Refresh the window, to update the information when dynamic update mode is off
e Acknowledge that you have seen dynamically updated dialog box changes

In addition, because the File System dialog box includes settings that you can modify to change how the
file system is monitored, the File System Properties dialog box contains a Save button.

Dynamic updates are displayed in blue. When an update occurs, the dialog box moves in front of other
open Cisco MGC Node Manager windows. Click the Acknowledge button to acknowledge you have
seen changes and remove the blue highlighting.

Figure 8-1 Device Properties Dialog Box Toolbar

Ms EB Y

Viewing Properties for Devices

Step 1
Step 2

You can view properties for any of the Cisco MGC node devices:
e (Cisco MGC host
e HSI server
e BAMS
e Cisco SLT
e Cisco LAN switch
Property fields vary with the device.

Use the following procedure to view properties for a device:

From the Map Viewer, select the desired device or devices.
Right-click, and choose Properties.

The Properties dialog box appears.

[ oL-9110-01
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M Viewing Properties for Devices and Their Components

Step 3

Step 4

Note

If you have selected more than one device, choose the desired device in the list box on the left side of
the dialog box.

Check device properties. See the “About the Device Properties Dialog Box™ section on page 8-10 for
details on properties.

(Optional) In the Properties dialog box, you can use the toolbar buttons or menu options to manipulate
the display.

The status bar shows the current status of the device.

About the Device Properties Dialog Box

The General Tab

The Details Tab

The Properties dialog box contains a toolbar and tabs displaying various categories of device properties.
The contents of tabs varies with the device type.

By default, the Properties dialog is dynamically updated as device information changes. You can use
toolbar buttons to turn updating on or off, acknowledge that you have seen updated information, and
check for changes as desired when dynamic updating is off. All fields are display-only.

See the “Common Functionality in Properties Dialog Boxes” section on page 8-8 for more information
on dialog box functionality.

The General tab contains the following display-only fields:

Management Address—Network management IP address.

System Name—Administratively assigned name for the device.

Location—Physical location of the device.

Contact—Contact person or organization and brief contact information, such as phone number.

(BAMS, HSI server, and Cisco MGC only) System Status—Current operational status of the device.
Values are Active, Standby, Outage, Error, and Other.

Up-time—Time since the device was initialized.

Description—Description of the device.

The Details tab contains the following fields:

For the Cisco MGC, HSI server, and BAMS
Hardware Model—Hardware model for the device.
OS Version—Version of the operating system.

OS Release—Release level of the operating system.
Host ID—Host ID.

Memory Size—Amount of physical main memory.

System Date—Local time and day on the host.
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Last Boot Time—Time the machine was last booted.

For the Cisco SLT and Cisco LAN Switch

Model—Chassis type.

Chassis ID—Unique identifier for the chassis (Cisco SLT) or serial number (Cisco LAN switch).
For the Cisco SLT only

Hardware Version—Chassis hardware revision level.

ROM System Version—ROM system software version.

ROM Monitor Version—ROM monitor version.

For the HSI server only

Host Port-1—The first port number to be used by the Cisco HSI. The default value is 0.

This value must match the peer port setting on the Cisco PGW 2200 EISUP IPLNK object.

Host Port-2—The second port number to be used by the Cisco HSI. The default value is 0. This value
should not be changed; it should always be set to 0.

For the Cisco LAN switch only

Fan Status—Status of the fan. Values are OK, Other, Minor Fault, and Major Fault.
Details area

System Type—Chassis system type.

Backplane Type—Chassis backplane type.

Power Supply area

Status (Primary and Secondary)—Power supply status. Values are OK, Other, Major Fault, and Minor
Fault.

Type (Primary and Secondary)—Type of power supply.

The Host, HSI, or BAMS Tab (Cisco MGC host, HSI server, or BAMS)

The Cisco MGC Host or BAMS tab contains the following fields:

In the Call Agent, BAMS Software, or HSI Software area, information about the software:
Host, BAMS Version, or HSI Version—Software version.

Patch Level—Patch level of the software.

(Cisco MGC only) Host Vendor—Vendor of the host software.

Home Directory—Software home directory.

(Cisco MGC only) Active Config Name—Name of the active MML configuration, if any.
(Cisco MGC only) Desired State—Desired state of the platform, such as standalone.

(Cisco MGC only) Switch Type—Switching configuration of the host.

In the Failover area, Failover Peer Addresses A and B—IP address of each of the failover machines.
For the HSI server only

Primary MGC—In the first row, under IP Address, the primary IP address of the primary Cisco PGW;
under Port, the first port number of the primary Cisco PGW.

[ oL-9110-01
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The Network Tab (all)

Viewing Properties for Devices and Their Components

~

Note

In the second row, the secondary IP address and the second port number of the primary Cisco PGW.
These must match the primary information in the first row.

Secondary MGC—In the first row, under IP Address, the primary IP address of the secondary Cisco
PGW; under Port, the first port number of the secondary Cisco PGW.

In the second row, the secondary IP address and the second port number of the secondary Cisco PGW.
These must match the information in the first row.

The Secondary MGC parameter is not used in a standalone Cisco PGW configuration.

The Network tab contains the following fields:

IP addresses configured on the device—IP addresses from the IP address table. A device can have more
than one IP address.

IP Address—IP address of the selected entity

Net Mask—Subnet mask associated with the IP address.

Interface Index—Interface on which the IP address is configured.

The Cisco LAN switch also contains these fields:

Broadcast Address—The broadcast address of the switch.

Net Mask—The net mask of the chassis.

Booted Image—The name of the image from which the system was booted.

Last Configuration Change—Time (in hundredths of a second) since the configuration of the system was
last changed.

The Cisco MGC host also contains a Configuration area:

IP addresses configured on the Call Agent—Cisco MGC host network addresses.

The Software Tab (Cisco MGC host, HSI server, and BAMS)

The Software tab contains the following fields describing software installed on the device:

The software running on the selected device—A list of installed software. Select the software whose
details you want to view.

Name—Name of the selected software.

Parameters—Parameters supplied to the software when it was run.

Path—Location from where the software was run.

Type—Type of software, such as operating system or device driver.

Status—Status of the running software. Values are Running, Runnable, Not Runnable, and Invalid.
These fields apply to the Cisco MGC host overall:

Number of Processes—Actual: Number of process contexts currently running. Maximum: Number of
process contexts this system can support.

Number of Users—Actual: Number of user sessions for which this host is storing information.
Maximum: Number of user sessions this host can support.
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The Virtual IP Tab (Cisco MGC host)

The Virtual IP tab contains the following fields:

Pool Name—Name assigned to the selected memory pool, such as DRAM.
Virtual IP address 1-Virtual IP address from MGC host.

Virtual IP Address 2- Second Virtual IP address from MGC host.

The Memory Tab (Cisco SLT and Cisco LAN Switch)

Memory Pool—A list of memory pools supported by the device. Select the memory pool whose details
you want to view.

Pool Name—Name assigned to the selected memory pool, such as DRAM.

Memory Used—Number of memory pool bytes that are currently in use by applications.
Memory Free—Number of memory pool bytes that are unused.

Largest Free—Largest number of contiguous bytes that are currently unused.

Cisco SLT only:

Configuration Memory—Bytes of nonvolatile configuration memory In Use/Total bytes of nonvolatile
configuration memory.

Processor RAM—Bytes of RAM available to the CPU.

The Configuration Tab (Cisco SLT)

The Poll Tab (BAMS)

History area

Configuration events on the device—List of configuration events in the device history. Select a device
to view its details.

Event Time:

Source—Source of the selected configuration event.
Destination—Configuration data destination for the event.
Image Name—Name of the system boot image.

Reason for Last Reload—Reason the system was last restarted.

Running Last Changed—Value of system uptime (sysUpTime) when the running configuration was last
changed.

Startup Last Changed—Value of system uptime when the startup configuration was last saved.

Running Last Saved—Value of system uptime when the running configuration was last saved.

Poll information—Poll table.

Host Name (primary and secondary)—Cisco MGC host for this BAMS.
Prefix (primary and secondary)—Prefix for data files on the host.

Suffix (primary and secondary)—Suffix for data files on the host.

Remote Directory (primary and secondary)—Remote directory on the host.

Action—Action to perform after polling.

[ oL-9110-01
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Interval—Polling unit (in minutes). Default value is 10.
Timeout—Timeout for file transfer. Default value is 10.

Maxtries—Maximum number of retries on each file. Default value is 3.

The RAS Parameters Tab (HSI Server)

Gatekeeper ID—Identifying name of the gatekeeper with which the endpoint is trying to register.
Gateway Prefix—The telephone prefix for which the gateway is registering as being able to terminate.

RAS Port—Number of the port receiving all RAS transactions for the current endpoint. Set to 0 to allow
the OS to look for the available port.

Gatekeeper IP Address—.The IP address of a known gatekeeper with which an endpoint might attempt
to register.

Gatekeeper Port—The port associated with the Gatekeeper IP Address, which can be either a
well-known port or another port by agreement.

Viewing Properties for Interfaces

You can view properties for serial, Ethernet, loopback, and TDM interfaces of the various Cisco MGC
node devices. You can view properties for the ports, VLAN, and SCO/SLO interfaces of the Cisco LAN
switch.

Use the following procedure to view properties information for interfaces:

Step 1 From the Map Viewer, select the desired interface.

~

Note  Find TDM interfaces under the Cisco SLT.

Step2  Right-click, and choose Properties.
The Properties dialog box appears.

Step 3 If you have selected more than one device, choose the desired device in the list box on the left side of
the dialog box.

Check device properties. See the “About the Serial, Ethernet, Loopback, and SCO/SLO Interface
Properties Dialog Box™ section on page 8-15 and the “About the TDM Interface Properties Dialog Box”
section on page 8-15 for details on interface properties.

Step4  (Optional) In the Properties dialog box, you can use the toolbar buttons or menu options to:
e Print the information on the current tab
¢ Close the dialog box
e Toggle dynamic update mode off and on
e Refresh the window to update the information when dynamic update mode is off

e Acknowledge that you have seen dynamically updated changes
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Viewing Properties for Devices and Their Components [l

~

Note  The status bar shows the current status of the interface.

About the Serial, Ethernet, Loopback, and SCO/SLO Interface Properties Dialog Box

The General Tab

The Details Tab

The Serial, Ethernet, Loopback, and SCO/SLO Interface Properties dialog boxes contain a toolbar and
a General and Details tab. All fields are display-only.

By default, the Properties dialog is dynamically updated as device information changes. You can use
toolbar buttons to turn updating on or off, acknowledge that you have seen updated information, and
check for changes as desired when dynamic updating is off.

See the “Common Functionality in Properties Dialog Boxes” section on page 8-8 for more on dialog box
functionality.

The General tab contains the following display-only fields:

(Ethernet, Loopback, and SCO/SLO) Physical Address—The interface address at the protocol sublayer.
Description—A description of the interface.

System Name—The administratively-assigned name for the interface.

Interface Type—The type of interface, such as FDDI.

Admin Status—The desired state of the interface. Values are Up, Down, or Testing.

Operational Status—The current operational state of the interface. Values are Up, Down, Testing,
Unknown, Dormant, Not Present, and Lower Layer Down.

The Details tab contains the following fields:

Interface Index—Index of this interface in the interface table (ifTable).

MTU—Size of the largest packet that can be sent or received on the interface.

(Ethernet, Serial, SCO/SLO only) Speed—Estimated speed of the interface, in bits per second.

Last Change—Time at which an interface was last created or deleted.

About the TDM Interface Properties Dialog Box

The TDM Interface Properties dialog box contains a toolbar and a General and Details tab. All fields are
display-only.

By default, the Properties dialog is dynamically updated as device information changes. You can use
toolbar buttons to turn updating on or off, acknowledge that you have seen updated information, and
check for changes as desired when dynamic updating is off.

See the “Common Functionality in Properties Dialog Boxes” section on page 8-8 for more on dialog box
functionality.

[ oL-9110-01
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The General Tab

The General tab contains the following display only fields:
Description—A description of the interface.

System Name—The administratively assigned name for the interface.
Circuit ID—Transmission vendor’s circuit identifier.
Speed—Estimated speed of the interface, in bits per second.

Interface Index—Index of this interface in the interface table (ifTable)
Interface Type—The type of interface, such as FDDI.

Line Type—DSI1 line type.

Line Coding—Variety of Zero Coding Suppression used on the link.

Last Change—Time at the last creation or deletion of an interface.

The Details Tab

The Details tab contains the following fields:
Status area
Admin Status—The desired state of the interface. Values are Up, Down, and Testing.

Operational Status—The current operational state of the interface. Values are Up, Down, Testing,
Unknown, Dormant, Not Present, and Lower Layer Down.

Line Status—Alarm status of the line.
Configuration area
Signal Mode—Signaling mode. Values are None, Robbed bit, Bit oriented, and Message oriented.

Send Code—Type of code sent across the interface. Values are No code, Line code, Payload code, and
Reset code.

Facilities Data Link—Use of the facilities data link.

Loopback Config—Loopback configuration of the interface. Values are No loop, Payload loop, line loop,
and other loop.

Transmit Clock Source—Source of the transmit clock. Values are Loop timing, local timing, and through
timing.

About the Cisco LAN Switch Port Properties Dialog Box

The Port Properties dialog box contains a toolbar and a General, Details, and VLAN tab. All fields are
display-only.

By default, the Properties dialog is dynamically updated as device information changes. You can use
toolbar buttons to turn updating on or off, acknowledge that you have seen updated information, and
check for changes as desired when dynamic updating is off.

See the “Common Functionality in Properties Dialog Boxes” section on page 8-8 for more on dialog box
functionality.

The General Tab

The General tab contains the following display-only fields:
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Physical Address—The interface address at the protocol sublayer.

Description—A description of the interface.

System Name—The administratively assigned name for the interface.

Interface Type—The type of interface, such as FDDI.

Admin Status—The desired state of the interface. Values are Up, Down, and Testing.

Operational Status—The current operational state of the interface. Values are Up, Down, Testing,
Unknown, Dormant, Not Present, and Lower Layer Down.

MTU—Size of the largest packet that can be sent or received on the interface.

Last Change—Time at the last creation or deletion of an interface.

The Details tab contains the following fields:
Port Name—Name of the port.
Port Type—Type of physical layer medium dependent interface on the port.

Port Status—Current operational status of the port. Values are Up, Down, Testing, Unknown, Dormant,
Not Present, and Lower Layer Down.

Duplex—Indicates if port is operating in half-duplex, full-duplex, disagree, or auto-negotiation mode.

Span Tree Fast Start—Whether the port is operating in span tree fast mode. Values are Enabled and
Disabled.

Desired Speed—Desired speed of the port, in bits per second.

Speed—Estimated speed of the interface, in bits per second.

The VLAN tab contains the following fields:
VLAN Number—Number assigned to the port.

Switching Priority—Priority level the port uses to access the switching media. Values are Normal, High,
and Not Applicable.

Admin Status—Indicates whether the port will be assigned to a VLAN statically or dynamically. Values
are Static and Dynamic.

Operational Status—Current VLAN status of the port. Values are Inactive, Active, Shutdown, and
VLAN Active Fault.

About the Cisco LAN Switch VLAN Properties Dialog Box

The VLAN Properties dialog box contains a toolbar and the fields described below. All fields are
display-only.

By default, the Properties dialog is dynamically updated as device information changes. You can use
toolbar buttons to turn updating on or off, acknowledge that you have seen updated information, and
check for changes as desired when dynamic updating is off.

See the “Common Functionality in Properties Dialog Boxes” section on page 8-8 for more on dialog box
functionality.

Fields:

[ oL-9110-01
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System Name—The administratively assigned name for the interface.

Spanning Tree Enabled—Whether spanning tree protocol is enabled for this VLAN.

Viewing Properties for the Cisco SLT SS7 MTP2 Channel

Step 1
Step 2

Step 3

Step 4

Step 5

Use the following procedure to view properties information for the MTP2 channel:

From the Map Viewer, select the Cisco SLT.
Right-click and choose Channels > MTP2 Channel Properties.
The SS7 MTP2 Properties dialog box appears.

If you have selected more than one device, choose the desired device in the list box on the left side of
the dialog box.

Check device properties. See the “About the Serial, Ethernet, Loopback, and SCO/SLO Interface
Properties Dialog Box™ section on page 8-15 or the “About the TDM Interface Properties Dialog Box”
section on page 8-15 for details on interface properties.

(Optional) In the Properties dialog box, you can use the toolbar buttons or menu options to:
e Print the information on the current tab
¢ Close the dialog box
e Toggle dynamic update mode off and on
e Refresh the window to update the information when dynamic update mode is off

e Acknowledge that you have seen dynamically-updated changes

a~

Note  The status bar shows the current status of the channel.

About the SS7 MTP2 Channel Properties Dialog Box

The Cisco SLT SS7 MTP2 Channel Properties dialog box contains a toolbar and the fields described
below. All fields are display-only.

By default, the Properties dialog is dynamically updated as device information changes. You can use
toolbar buttons to turn updating on or off, acknowledge that you have seen updated information, and
check for changes as desired when dynamic updating is off.

See the “Common Functionality in Properties Dialog Boxes” section on page 8-8 for more information
on dialog box functionality.

Channel Number—MTP2 channel number

Link Status—Overall status of the link

Alignment Error Rate Monitor—Status of the alignment error rate monitor state machine
Signal Unit Error Monitor—Status of the signal unit error monitor (SUERM)
Transmission Control—Status of the initial alignment control state machine

Receive Control—Status of the receive control state machine
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Remote Processor Outage—Processor outage status of the remote

Congestion Backhaul—Status of the congestion control state between the Cisco MGC host and the
Cisco SLT

Congestion—Status of the congestion control state machine

Monitoring Cisco MGC Host, HSI Server, and BAMS File Systems

Step 1

Step 2

Step 3

Step 4

You can monitor file systems on the Cisco MGC host, HSI server, and BAMS as follows:
e View file system information
e Set a threshold to have the device send a trap if file system usage passes the threshold
e View which file systems have exceeded their threshold

e Poll file systems at a desired frequency, specifying a global polling frequency or individual
frequencies for each file system

e Poll all file systems now
e Turn traps on or off for individual file systems based on trap severity

Use the following procedure to monitor Cisco MGC host, HSI server, or BAMS file systems:

In the Map Viewer, select the desired Cisco MGC host, HSI server, or BAMS,

a~

Note  Alternatively, if you have an Accounts, Properties, States, or Diagnostics dialog box open for the
device, you can use the dialog box Navigation menu to open the File Systems dialog box.

Right-click, and choose File Systems.

The File System Properties dialog box appears, displaying file system properties and settings for
monitoring the file system.

If there is more than one selected device, the details shown apply to the currently highlighted device. In
the list, click the device whose details you want to view or change. See the “About the File System
Properties Dialog Box™ section on page 8-20 for details.

Check or change settings as needed:
e Use the General tab to view file system information.
¢ Use the Monitor tab to change settings for monitoring file system usage.
¢ Use the Exception tab to check file systems that have crossed their threshold.

~

Note  You can use the Navigation menu to open the Properties, Accounts, States, or Diagnostics dialog
box for the selected component.

If you make changes, click the toolbar Save button.

[ oL-9110-01
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About the File System Properties Dialog Box

Note

The File System Properties dialog box contains a toolbar and a single tab (General, Monitoring, and
Exceptions).

By default, the Properties dialog is dynamically updated as device information changes. You can use
toolbar buttons to turn updating on or off, acknowledge that you have seen updated information, and
check for changes when dynamic updating is off.

See the “Common Functionality in Properties Dialog Boxes” section on page 8-8 for more on dialog box
functionality. Unlike other Properties dialog boxes, the File System Properties dialog box includes a
toolbar Save button for saving changes to monitoring specifications.

The General Tab

File System—List of file systems for this device. Select a system to view details.
Capacity—Percentage of normally available space that is currently allocated to files on the system.
Used Space—Amount of space allocated to existing files.

Free Space—Total amount of space available for the creation of new files by unprivileged users.
Mount Point—Mount point (directory) of the file system.

The Monitor Tab

File System—List of file systems. Select a system to check or change monitoring settings.

Current Utilization—Percent of disk space currently In Use/Percent full at which an event (alarm) will
be triggered for the selected file system. Set alarm severity with Trap Severity.

Poll Interval—Period in seconds when this file system should be checked to see if it exceeds its
threshold.

The Poll Now function is not currently supported for an individual file system. Global (all file systems)
Poll Now is supported.

Threshold Command—Command to execute when the threshold is exceeded.

Trap Severity—Severity of the trap that is sent when the threshold is exceeded. Values are Warning and
Critical.

When Above Threshold—Send a trap if the threshold is exceeded. Values are Send Trap and Don’t Send
Trap. Use Don’t Send Trap to turn off notification for the selected file system.

When Below Threshold—Send a trap if the file system usage falls below the threshold. Values are Send
Trap and Don’t Send Trap. Use Don’t Send Trap to turn off notification for the selected file system.

Global Poll Interval—Period in seconds when all file systems should be checked to see if any exceed the
threshold.

Poll Now button—Check all file systems for this device immediately.
The Exceptions Tab

File system list box—L.ist of file systems that have exceeded their threshold. Select a file system to view
details.

File System—Name of the selected file system.
Threshold—Threshold that has been exceeded.

Current Utilization—Current percent utilization of the file system.
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Viewing System Component Properties

You can check properties on the following system components of a Cisco MGC host, HSI server, or
BAMS:

e Disk partitions
e Processor
e RAM

e Virtual memory

Note  Forinformation about viewing performance data for system components, see Appendix B, “Performance
Measurements Reference,” “Performance Data Collected for System Components” section on page B-9.

Use the following procedure to view system component properties:

Step 1 In the Map Viewer, do one of the following:

e To view information for all components of a particular type, select a Cisco MGC host, HSI server,
or BAMS, and right-click. Choose Devices, then choose one of the following:

— Disk Partition Properties

Processor Properties
RAM Properties

Virtual Memory Properties

e To view information for a particular component, under the Cisco MGC host, HSI server, or BAMS,
select the component and right-click. Choose Properties.

The dialog box displays information on the selected component’s properties. See the “About the
System Components Properties Dialog Boxes” section on page 8-21 for details.

Step2  (Optional) In the Properties dialog box, you can use the toolbar buttons or menu options to:
e Print the information on the current tab
¢ Close the dialog box
e Toggle dynamic update mode off and on
e Refresh the window to update the information when dynamic update mode is off

e Acknowledge that you have seen dynamically updated changes

About the System Components Properties Dialog Boxes
There are two types of Cisco MGC host, HSI server, and BAMS system component Properties dialog
boxes:
e A Properties dialog box for fixed disk, RAM, and virtual memory

e A Properties dialog box for the processor

Cisco Media Gateway Controller Node Manager User's Guide, 2.6(1)
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By default, the Properties dialog is dynamically updated as device information changes. You can use
toolbar buttons to turn updating on or off, acknowledge that you have seen updated information, and
check for changes as desired when dynamic updating is off.

See the “Common Functionality in Properties Dialog Boxes” section on page 8-8 for more on dialog box
functionality.

Fixed Disk, RAM, and Virtual Memory Properties dialog box

Description—Description of the type and instance of the selected storage device.

Allocation Units—Size in bytes of the data object allocated from this pool.

Space Used—Amount of the storage that is allocated.

Total Size—Size of the total device storage.

Allocation Failures—Number of requests for storage that could not be honored.

Processor Properties dialog box

Description—Description of the processor.

Status—Current operating status. Values are Running, Unknown, Testing, Warning, and Down.

Utilization—Average over the last minute of the percent of time that the processor was active.

Errors—Number of errors detected on this device.

Viewing Dial Plan Component Properties

You can view properties of the following dial plan components of a Cisco MGC node:

A- and B-digit trees
Routes
Routing

Dial plan properties

In addition, you can set and view these relationships between dial plan components:

The relationship between conditional route and day of the week. A single conditional route can be
associated with one or more conditional route descriptors on a given day, or it can be related to the
same descriptor on multiple days. In the Map Viewer, this appears under the conditional route as
Conditional Route Day, the day of the week with the conditional route name appended to it.

The relationship between conditional route descriptor and the route list or percentage route. A single
conditional route descriptor can be associated with one or more conditional route lists or one or more
percentage routes. In the Map Viewer, this appears under the conditional route as Conditional Route
Descriptor Details, the route list or percentage route (whichever the descriptor is associated with)
with the conditional route descriptor name appended to it.

The relationship between the percentage route and the route list or conditional route. A single
percentage route can be associated with one or more conditional routes or one or more route lists.
In the Map Viewer, this appears under the percentage route as Percentage Route Descriptor, the route
list or conditional route with the percentage route name appended to it.

Use the following procedure to view dial plan component properties:
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Step1  In the Map Viewer, do one of the following:

To view information for all components of a particular type, select the dial plan folder and
right-click. Choose one of the following:

- Digit Trees and then one of the following:
A-Digit Tree Properties
B-Digit Tree Properties

— Routes and then one of the following:
Route Trunk Properties
Route List Properties
Route Trunk Group Properties
Bearer Cap(ability) Properties

— Routing and then one of the following:

Percentage Routes > Percentage Route or Relationship between Percentage Route and
RouteList/Conditional Route

Conditional Routes > Conditional Route, Relationship between Conditional Route and Day of
Week, Conditional Route Descriptor, Conditional Route Descriptor Details, or Relationship
between Conditional Route Descriptor and RouteList/Percentage Route

Route Holiday Properties
Result Table Properties
Result Set Properties
CPC Properties
Codec String Properties
TMR Properties
TNS Properties

— Dial Plan Properties

To view information for a particular component, under the dial plan folder, select the desired
component, and right-click. Choose Properties.

The dialog box displays information on the selected component’s properties. See the “About the Dial
Plan Properties Dialog Boxes” section on page 8-24 for details.

Step2  (Optional) In the Properties dialog box, you can use the toolbar buttons or menu options to:

Print the information on the current tab.

Close the dialog box.

Toggle dynamic update mode off and on.

Refresh the window to update the information when dynamic update mode is off.

Acknowledge that you have seen dynamically-updated changes.

[ oL-9110-01
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About the Dial Plan Properties Dialog Boxes

The various Properties dialog boxes for dial plan components contain a toolbar and the fields described
in Table 8-2. By default, the Properties dialog is dynamically updated as device information changes.
You can use toolbar buttons to turn updating on or off, acknowledge that you have seen updated
information, and check for changes as desired when dynamic updating is off.

See the “Common Functionality in Properties Dialog Boxes” section on page 8-8 for more information
on dialog box functionality.

Table 8-2 Properties of Dial Plan Components

[l Cisco Media Gateway Controller Node Manager User's Guide, 2.6(1)

Field Name

Definition

A- or B-Digit Tree Properties dialog box

Customer Group ID

ID of the customer associated with the selected trunk group.

Digit String

All the digits in a calling or called number.

Digit-to-Present

Number of digits to skip (backward or forward) during analysis. Enter - to
skip backwards.

Set Name

Name of the result set for the selected component.

Call side

Side of the call. Values are Originating and Terminating.

Route Trunk Properties dialog box

MML Name

Name of the component.

Trunk Group

Name of the trunk group.

Next Trunk Group

Trunk group number of the next trunk group, if any

Weighted Trunk

Set to on if weighted trunk group routing is desired. Values are On or Off.

Route List Properties dialog box

MML Name

Name of the component.

Route Name

Name of the route.

Carrier ID

Carrier ID with which users on this trunk group are associated.

Distribution

Sequential distribution. Values are On (trunk groups in a route are selected
sequentially) and Off (trunk groups in a route are selected randomly).

Route Trunk Group Properties dialog box

MML Name

Name of the component.

Trunk Type

The trunk transmission media.

Cut-through

The point in the calling process where the trunk is seized from end point
to end point.

Queuing

Duration in seconds the call is queued.

Reattempts

The number of times the system attempts to select a trunk group.

Reserve Circuits %

Reserve circuits percentage.

Bearer Capability
Name

Bearer capability name (the MML name in the Bearer Capability
Properties dialog box)

SIP Route Trunk Group Properties

Bearer Capability
Name

Bearer capability name (the MML name in the Bearer Capability
Properties dialog box)
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Table 8-2 Properties of Dial Plan Components (continued)
Field Name Definition
Bearer Capability Properties (in the Map Viewer, appears under route trunk, route trunk group)
MML Name Name of the component, such as bearer1l
Bearer Capability Series of transmission medium requirements (TMR) values (see TMR
Properties), separated by semicolons, such as 12;05;21
Percentage Route Properties dialog box
MML Name Name of the component
Relationship between Percentage Route and RouteList/Conditional Route
Percentage Route Percentage route name
Name
Name
Over Flow Supported |Overflow supported
Over Flow This entry is the overflow entry [y/n]
Primary This entry is the primary entry [y/n]
Route List Name Route list name
Conditional Route Conditional route name
Name
Conditional Route Properties
MML Name Name of the component
Day of Week Day of the week
Relationship between Conditional Route and Day of Week
Conditional Route Name of the conditional route
Name
Day of Week Day of the week to associate with this conditional route, either a default or
a day between Sunday and Saturday, or one of the holiday days defined in
Route Holiday Properties.
Conditional Route Conditional route descriptor name
Descriptor
Conditional Route Descriptor Properties
MML Name MML name.
Relationship between Conditional Route Descriptor and RouteList/Percentage Route
Conditional Route Conditional route descriptor name
Descriptor
Start Time Time to start, in the form hhmm, 24 hour day
End Time TIme to end
Route List Name Route list name
Percentage Route Percentage based route name
Name
Primary The primary entry for percentage-based routing
Cisco Media Gateway Controller Node Manager User's Guide, 2.6(1)
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Table 8-2

Properties of Dial Plan Components (continued)

Field Name Definition

Route Holiday Properties

~

Note In the Map Viewer, the Route Holiday component appears under the dial plan object and is
named for the date, such as 2003.12.25.

Customer Group ID  |ID of customer associated with the selected trunk group.

Holiday Day Holiday day

Date of Holiday Date of the holiday, in the form YYYY.MM.DD

Result Set Properties dialog box

MML Name Name of the component

Customer Group ID  |ID of customer associated with the selected trunk group.

Result Table Properties dialog box

MML Name Name of the component.

Customer Group ID  |ID of customer associated with the selected trunk group.
Set Name Name of the result set.

Result type Type of result set.

Data word 1 to Data  |Data words 1 through 4.
word 4

CPC (Calling Party Category) Properties. These properties detect and effect routing based on CPC.

~

Note In the Map Viewer, the CPC component appears under the result set object, below the result
table, with a name in the form cpc-CPC value, such as “cpc-15”.

Customer Group ID  |ID of customer associated with the selected trunk group.

CPC Value Calling party category value

Set Name Name of the result set

Codec String Properties (in the Map Viewer, appears under result set, result table)

MML Name Name of the component, such as codecl

Codec String Set of codec choices separated by semicolons, such as
G.726-32;G.729b-L

TMR (Transmission Medium Requirements) Properties

~

Note Inthe Map Viewer, the TMR component appears under the result set object with a name in the
form tmr-TMR value, such as “tmr-1".

Customer Group ID  |ID of customer associated with the selected trunk group.

TMR Value Transmission medium requirements value

Set Name Name of the result set
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Table 8-2 Properties of Dial Plan Components (continued)

Field Name Definition

TNS (Transit Network Selection) Properties

~

Note In the Map Viewer, the TNS component appears under the result set object with a name in the
form tns-TNS value, such as “tns-333”.

Customer Group ID  |ID of customer associated with the selected trunk group.

TNS Value Transit network selection value

Set Name Name of the result set

Dial Plan Properties

Customer Group ID  |ID of customer associated with the selected trunk group.

Over-Decadic Status |Over-decadic status. Value: YES or NO.

Viewing Signaling Component Properties

You can view properties of the following signaling components of a Cisco MGC node:
e Paths
e Links
¢ Point codes
e External nodes
e Interfaces
e SS7 components
e M3UA/SUA Components

Use the following procedure to view signaling component properties:

Step1  In the Map Viewer, do one of the following:

¢ To view information for all components of a particular type, select the Signaling folder, and
right-click. Choose one of the following:

— Paths, then the desired type of path component. See Table 8-3 for dialog box details.
— Links, then the desired type of link component. See Table 8-4 for dialog box details.

— Point Codes, then the desired type of point code component. See Table 8-5 for dialog box
details.

Note In Cisco MGC Version 9.x, detailed DPC point code properties do not appear on the DPC
Properties dialog box Details tab. Instead, drill down from the DPC to the SS7 path object
(ss7svcl, for example), choose Properties, and in the Properties dialog box click the Details tab.

External Nodes, then the desired type of external node component. See Table 8-6 for dialog
box details.

Cisco Media Gateway Controller Node Manager User's Guide, 2.6(1)
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— Interfaces, then the desired type of interface component. See Table 8-7 for dialog box
details.

— SS7 Components, then the desired type of SS7 component. See Table 8-8 for dialog box
details.

- MB3UA/SUA Components, then either the M3UA Key or Route, or SUA Key or Route,
component. See Table 8-9 for details.

To view information for a particular component, under the Signaling folder, select the desired
component, and right-click. Choose Properties.

The dialog box displays information on the selected component’s properties. See the “About the
Signaling Components Properties Dialog Boxes” section on page 8-28 for details.

Step2  (Optional) In the Properties dialog box, you can use the toolbar buttons or menu options to:

Print the information on the current tab

Close the dialog box

Toggle dynamic update mode off and on

Refresh the window to update the information when dynamic update mode is off

Acknowledge that you have seen dynamically-updated changes

About the Signaling Components Properties Dialog Boxes

Table 8-3

8-28

The various Properties dialog boxes for signaling components contain a toolbar and fields described in
tables below for each component type. By default, the Properties dialog is dynamically updated as device
information changes. You can use toolbar buttons to turn updating on or off, acknowledge that you have
seen updated information, and check for changes as desired when dynamic updating is off.

Signaling path components, in Table 8-3
Signaling link components, in Table 8-4
Signaling point code components, in Table 8-5
Signaling external node components, in Table §-6
Signaling interface components, in Table 8-7
Signaling SS7 components, in Table 8-8
Signaling M3UA/SUA components, in Table §-9

See the “Common Functionality in Properties Dialog Boxes” section on page 8-8 for more on dialog box
functionality.

Properties of Signaling Path Components

Field Name Definition

Association Properties dialog box

General tab
MML Name Name of the component
Description Description of the MML component
Port Local SCTP port number.

Cisco Media Gateway Controller Node Manager User's Guide, 2.6(1)
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Table 8-3 Properties of Signaling Path Components (continued)
Field Name Definition

Peer Port Destination SCTP port number.

External Node Name of a previously configured external node.

First IP Address First local address.

Second IP Address Second local address.

First Peer Address The highest priority destination address.

Second Peer Address The lowest priority destination address.

Receive Window Bytes Number of bytes to advertise for the local receive window.

IP Route 1 MML name of the first IP route.

IP Route 2 MML name of the second IP route.

Time Between Heartbeats |Time between heartbeats. The heartbeat is this value plus the current
retransmission timeout value.

Max Retransmissions Maximum number of retransmissions to either the first or second peer
address before it is declared failed.

Internet Protocol Value placed in the IP Precedence portion of the Type of Service field

Precedence for outgoing SCTP datagrams.

Differential Service Code |Value placed in the DSCP portion of the Type of Service field for

Point outgoing SCTP datagrams.

Previously Configured MML name of a previously configured SGP.

SGP

Details tab

Maximum Init Maximum initial timer retransmission value.

Retransmission Timer

Max Retransmission Maximum value allowed for the retransmission timer.

Timer

Min Retransmission Minimum value allowed for the retransmission timer.

Timer

Maximum Maximum number of retransmissions over all destination addresses

Retransmissions to Dest  |before the association is declared failed.

Max Bundling Wait Time |Maximum time SCTP will wait for other outgoing datagrams for
bundling.

Max Init Retransmission |Maximum number of times to retransmit SCTP INIT message.

Times

Max Time Before Sending |Maximum time after a datagram is received before an SCTP SACK is

SACK sent.

Association State State of SCTP association

AXL Server Properties dialog Box

MML Name Name of the component

Description Description of the MML component

First IP Address First local address
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Table 8-3

Properties of Signaling Path Components (continued)

Field Name

Definition

Second IP Address

Second local address

Port Local SCTP port number

First Peer Address The highest priority destination address
Peer Port Destination SCTP port number

IP Route 1 MML name of the first IP route

IP Route 2 MML name of the second IP route

CTI Path CTI Sig Path component

Version The version of CTI Path supported by MGC

BRI Path Properties dialog box

MML Name

Name of the component

Description

Description of the MML component

External Node

MML Name of a previously configured external node

Side

User for user side and network for network side; (network)

MDO

Message definition object file protocol name

Customer Group ID

Four digit ID; (0000)

Call Ref Length

1 for 1 byte or 2 for 2 byte call reference length; (0)

Admin State

Administrative state of the component

Destination Association

Point-code state

Destination State

Destination Association

Destination Package

Destination Package

Locked

Number of bearer channels in LOCKED state

Unlocked

Number of bearer channels in UNLOCKED state

Shutdown

Number of bearer channels in SHUTDOWN state

CAS Path Properties dialog box

MML Name

Name of the component

Description

Description of the MML component

External Node

External node

Customer Group ID

ID of the customer associated with the selected trunk group

Side Q.931 call model side

Admin State Administrative state of the component

Locked Number of bearer channels in LOCKED state
Unlocked Number of bearer channels in UNLOCKED state
Shutdown Number of bearer channels in SHUTDOWN state

CTI Path Properties dialog

box

MML Name

Name of the component

Description

Description of the MML component
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Table 8-3 Properties of Signaling Path Components (continued)

Field Name Definition

External Node MML Name of a previously configured external node for this CTI
Path

CTI Manager Properties dialog box
MML Name Name of the component
Description Description of the MML component
First IP Address First local address
Second IP Address Second local address
Port Local SCTP port number
First Peer Address The highest priority destination address
Peer Port Destination SCTP port number
IP Route 1 MML name of the first IP route
IP Route 2 MML name of the second IP route
CTI Path CTI Sig Path component configured for this CTI Manager
Version The version of CTI Manager supported by MGC

DPNSS Path Properties dialog box

General tab
MML Name Name of the component
Description Description of the MML component
Destination Association | Type of association
Component Type Type of component
External Node External node
Customer VPN ID VPN customer name assigned to the selected trunk group
Customer Group ID ID of the customer associated with the selected trunk group
Signal Slot Physical slot on 2600/3660 (optional)
Signal Port Physical port on the slot of 2600/3660 (optional)
Destination Package Name of the installed package
A/B Flag DPNSS side

Details tab
Admin State Administrative state of the component
Destination State Destination state
Locked Number of bearer channels in LOCKED state
Unlocked Number of bearer channels in UNLOCKED state
Shutdown Number of bearer channels in SHUTDOWN state

EISUP Path Properties dialog box
MML Name Name of the component
Description Description of the MML component

Cisco Media Gateway Controller Node Manager User's Guide, 2.6(1)
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Table 8-3 Properties of Signaling Path Components (continued)
Field Name Definition
External Node External node
Customer Group Table Customer group table
Customer Group ID ID of the customer associated with the selected trunk group
Side Q.931 call model side
Admin State Administrative state of the component
Destination State Point-code state
Locked Number of bearer channels in LOCKED state
Unlocked Number of bearer channels in UNLOCKED state
Shutdown Number of bearer channels in SHUTDOWN state
FAS Path Properties dialog box
MML Name Name of the component
Description Description of the MML component
Customer Group Table Customer group table
Customer Group ID ID of the customer associated with the selected trunk group
Call Ref Length Call reference length
Side Q.931 call model side
MDO Message definition object file protocol name
A/B Flag A/B flag
ASP Part Auxiliary signaling path

IP FAS Path Properties dialog box

General tab

MML Name Name of the component

Description Description of the MML component

External Node External node

Customer Group Table Customer group table

Customer Group ID ID of the customer associated with the selected trunk group

Call Ref Length Call reference length

Side Q.931 call model side

MDO Message definition object file protocol name
Details tab

A/B Flag A/B flag

ASP Part Auxiliary signaling path

Admin State Administrative state of the component

Destination State Point-code state

Locked Number of bearer channels in LOCKED state

Unlocked Number of bearer channels in UNLOCKED state
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Table 8-3 Properties of Signaling Path Components (continued)
Field Name Definition
Shutdown Number of bearer channels in SHUTDOWN state
Label Properties dialog box
MML Name Name of the component
Description Description of the MML component
Call limit Max number of calls allowed on this location label. 0-n . Integer value
O(default)
MGCP Path Properties dialog box and SGCP Path Properties dialog box
MML Name Name of the component
Description Description of the MML component
External Node External node
NAS Path Properties dialog box
General tab
MML Name Name of the component
Description Description of the MML component
External Node External node
MDO Message definition object file protocol name
Customer Group ID ID of the customer associated with the selected trunk group
Signal Slot Physical slot on the NAS defining the NFAS Group (optional)
Signal Port Physical port on the slot of NAS defining the NFAS Group (optional)
Details tab
Admin State Administrative state of the component
Destination State Point-code state
Locked Number of bearer channels in LOCKED state
Unlocked Number of bearer channels in UNLOCKED state
Shutdown Number of bearer channels in SHUTDOWN state
Session Set Properties dialog box
General tab
MML Name Name of the component
Description Description of the MML component
External Node External node
First IP Address First logical IP address
Second IP Address Second logical IP address
First Peer Address Remote IP address 1
Second Peer Address Remote IP address 2
Ext Node Type Session set external node type
IP Route 1 Name of first IP route
Cisco Media Gateway Controller Node Manager User's Guide, 2.6(1)
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Table 8-3

Properties of Signaling Path Components (continued)

Field Name

Definition

IP Route 2

Name of second IP route

Details tab

Port

Local port number of link interface on the Cisco MGC host

Peer Port

Port number of the link interface on the remote device

Network Mask Address 1

Network mask (not supported after Cisco MGC 9.3(2))

Next Hop Address 1

Next hop (not supported after Cisco MGC 9.3(2))

Network Mask Address 2

Network mask (not supported after Cisco MGC 9.3(2))

Next Hop Address 2

Next hop (not supported after Cisco MGC 9.3(2))

SIP Path Properties dialog box

MML Name Name of the component

Description Description of the MML component

MDO Message definition object file protocol name
Admin State Administrative state of the component

Locked Number of bearer channels in LOCKED state
Unlocked Number of bearer channels in UNLOCKED state
Shutdown Number of bearer channels in SHUTDOWN state

SS7 Path Properties dialog box

General tab

MML Name

Name of the component

Description

Description of the MML component

Customer Group ID

ID of the customer associated with the selected trunk group

Customer Group Table

Customer group table

ASP Part

Auxiliary signaling path

MDO Message definition object file protocol name
Side Q.931 call model side

OPC Originating point code

DPC Destination point code

M3UAKey MML name of M3UAKEY

Details tab

Admin State

Administrative state of the component

Destination State

Point-code state

Locked Number of bearer channels in LOCKED state
Unlocked Number of bearer channels in UNLOCKED state
Shutdown Number of bearer channels in SHUTDOWN state

SS7 Signaling Gateway Path Properties dialog box

General tab

[l Cisco Media Gateway Controller Node Manager User's Guide, 2.6(1)

0L-9110-01



| Chapter8

Other Network Management Tasks

Viewing Properties for Devices and Their Components

Table 8-3 Properties of Signaling Path Components (continued)

Field Name Definition
MML Name Name of the component
Description Description of the MML component
Customer Group ID ID of the customer associated with the selected trunk group
Customer Group Table Customer group table
ASP Part Auxiliary signaling path
MDO Message definition object file protocol name
Side Q.931 call model side
OPC Originating point code
DPC Destination point code
Signaling Gateway Pair Name of a pair of SS7 signaling gateway nodes

Details tab
Admin State Administrative state of the component
Locked Number of bearer channels in LOCKED state
Unlocked Number of bearer channels in UNLOCKED state
Shutdown Number of bearer channels in SHUTDOWN state
Destination State Point-code state

TCAP Path Property dialog box
MML Name Name of the component
Description Description of the MML component
External Node External node
Customer Group ID ID of the customer associated with the selected trunk group
Side Q.931 call model side
Admin State Administrative state of the component
Locked Number of bearer channels in LOCKED state
Unlocked Number of bearer channels in UNLOCKED state
Shutdown Number of bearer channels in SHUTDOWN state
Label Properties dialog box
MML Name Name of the component
Description Description of the MML component
Call Limit Max number of calls allowed on this location label. 0-n . Integer value

O(default)
AXL Server Properties dialog box
MML Name Name of the component
Description Description of the MML component
First IP Address First local address
Second IP Address Second local address
Cisco Media Gateway Controller Node Manager User's Guide, 2.6(1)
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Table 8-3

Table 8-4

Properties of Signaling Path Components (continued)

Field Name Definition
Port Local SCTP port number
First Peer Address The highest priority destination address
Peer Port Destination SCTP port number
IP Route 1 MML name of the first IP route
IP Route 2 MML name of the second IP route
CTI Path CTI Sig Path component
Version The version of CTI Path supported by MGC

CTI Path Properties dialo

g box

MML Name

Name of the component

Description

Description of the MML component

External Node

MML Name of a previously configured external node for this CTI
Path

CTI Manager Properties dialog box

MML Name

Name of the component

Description

Description of the MML component

First IP Address

First local address

Second IP Address

Second local address

Port Local SCTP port number

First Peer Address The highest priority destination address

Peer Port MML name of the first IP route

IP Route 1 MML name of the first IP route

IP Route 2 MML name of the second IP route

CTI Path CTI Sig Path component configured for this CTI Manager
Version The version of CTI Manager supported by MGC

Properties of Signaling Link Components

Field Name Definition

C7 IP Link Properties dialog box

General tab
MML Name Name of the component
Description Description of the MML component
IP Address IP address
Interface Ethernet interface to which the link connects
Priority Priority of the route
Timeslot Time slot used by the link
Details tab

[l Cisco Media Gateway Controller Node Manager User's Guide, 2.6(1)
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Table 8-4 Properties of Signaling Link Components (continued)
Field Name Definition
Port Local port number of the link interface on the Cisco MGC host
Peer Address Remote IP address of link address
SLC SS7 signaling link code
Signal Channel State State of the signaling channel
Network Mask Network mask
Next Hop Next hop
D Channel Properties dialog box
MML Name Name of the component
Description Description of the MML component
Service Signaling service
Status Operational status of the D-channel
Priority Priority of the route
Signal Slot Physical slot on the gateway into which the T1/E1 is plugged
Signal Port Physical port on the gateway
Session Set Session set of backhaul link to the gateway
TCP Link Name of an existing TCP Link
Sub Unit Only for BRI D Channel. Integer O or 1.
IP Link Properties dialog box
MML Name Name of the component
Description Description of the MML component
IP Address IP address
Interface Ethernet interface to which the link connects (not supported after
Cisco MGC 9.3(2))
Service Signaling service
Priority Priority of the route
Port Local port number of link interface on the Cisco MGC host
Peer Port Port number of the link interface on remote device
Signal Slot Physical slot on the gateway into which the T1/E1 is plugged
Signal Port Physical port on the gateway
Signal Channel State State of the signaling channel
Network Mask Network mask (not supported after Cisco MGC 9.3(2))
Next Hop Next hop (not supported after Cisco MGC 9.3(2))
IP Route IP route’s MML name
State State of the IP route
IP Route Properties dialog box
MML Name Name of the component
Cisco Media Gateway Controller Node Manager User's Guide, 2.6(1)
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Table 8-4

8-38

Properties of Signaling Link Components (continued)

Field Name Definition
Description Description of the MML component
IP Address Local IP address
Destination Destination hostname or IP address

IP Route State

IP Route state

Priority Priority of the route
Network Mask Subnet mask of destination (optional)
Next Hop Next hop router IP address

Link Set Properties dialog box

MML Name

Name of the component

Description

Description of the MML component

Protocol Family

Protocol used by the component

APC

Adjacent point code for an STP

Linkset Type

Type of transport for this link set

Linkset State

Service state of the link

SIP Link Properties dialog box

General tab

MML Name Name of the component

Description Description of the MML component

IP Address IP address

Interface Ethernet interface to which the link connects (not supported after
Cisco MGC 9.3(2))

Priority Priority of the route

Details tab

Service

Type of signaling service

Port

Local port number of the link interface on the Cisco MGC host

Signal Channel State

State of the signaling channel

Network Mask

Network mask (not supported after Cisco MGC 9.3(2))

Next Hop

Next hop (not supported after Cisco MGC 9.3(2))

SS7 Signaling Gateway IP Link Properties dialog box

MML Name

Name of the component

Description

Description of the MML component

Signaling Gateway Node

State of the signaling channel

IP Address IP address

Peer Address IP address of the remote peer

Peer Port Port number of the link interface on the remote device

Interface Ethernet interface to which the link connects (not supported after

Cisco MGC 9.3(2))
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Table 8-4 Properties of Signaling Link Components (continued)
Field Name Definition
Priority Priority of the route
SLC SS7 Signaling Link Code
Signal Channel State State of the signaling channel
TDM Link Properties dialog box
MML Name Name of the component
Description Description of the MML component
Interface Ethernet interface to which the link connects
Priority Priority of the route
Timeslot Time slot used by the link
Service Type of signaling service
SLC SS7 signaling link code
TCP Link Properties dialog box
MML Name Name of the component
Description Description of the MML component
IP Address IP address
Type Signaling Type. BRI
Port Local port number of link interface on the Cisco MGC host
IP Route IP route's MML name
External Node External node
Peer Port Port number of the link interface on remote device
Peer Address Peer IP address
Signal Channel State State of the signaling channel
Table 8-5 Properties of Signaling Point Code Components
Field Name Definition
APC Properties dialog box
MML Name Name of the component
Description Description of the MML component
Network Address SS7 network address in dotted notation
Network Indicator Indicator assigned by the network administrator
OPC Originating point code
DPC Destination point code
Route Set State State of the point code
DPC Properties dialog box
General tab
Cisco Media Gateway Controller Node Manager User's Guide, 2.6(1)
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Table 8-5 Properties of Signaling Point Code Components (continued)

Field Name Definition
MML Name Name of the component
Description Description of the MML component
Network Address SS7 network address in dotted notation
Network Indicator Indicator assigned by the network administrator
OPC Originating point code
DPC Destination point code

Details tab
Admin State Administrative state of the component
Route Set State State of the point code
Destination State Point-code state
Locked Number of bearer channels in LOCKED state
Unlocked Number of bearer channels in UNLOCKED state
Shutdown Number of bearer channels in SHUTDOWN state

OPC Properties dialog box
MML Name Name of the component
Description Description of the MML component
Network Address SS7 network address in dotted notation
Network Indicator Indicator assigned by the network administrator
OPC Type Originating point code

Table 8-6 Properties of Signaling External Node Components

Field Name

Definition

External Node Properties dialog box

MML Name

Name of the component

Description

Description of the MML component

Extnode Type

Type of the external node

Admin State

Administrative state of the component

Locked Number of bearer channels in LOCKED state
Unlocked Number of bearer channels in UNLOCKED state
Shutdown Number of bearer channels in SHUTDOWN state
M3UA/SUA Group M3UA/SUA group number

Number

ISDN Signaling Type

ISDN signaling type (optional)

SGP Properties dialog box

MML Name

Name of the component

Description

Description of the MML component

Cisco Media Gateway Controller Node Manager User's Guide, 2.6(1)
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Table 8-6 Properties of Signaling External Node Components (continued)
Field Name Definition
External Node External node’s MML name
SGP State State of the Signaling Gateway Process
Signaling Gateway Node Properties dialog box
MML Name Name of the component
Description Description of the MML component
Type Type of SS7 Signaling Gateway Node
State SS7 Signaling Gateway Node status
Signaling Gateway Node Pair Properties dialog box
MML Name Name of the component
Description Description of the MML component
Signaling Gateway Node |[SS7 signaling gateway node
Mated SG Node Mated SS7 signaling gateway node
Table 8-7 Properties of Signaling Interface Components
Field Name Definition
Card Interface Properties dialog box
MML Name Name of the component
Description Description of the MML component
Card Type Type of card or adapter
Slot Location of card or adapter within host device
Ethernet Interface Properties dialog box
MML Name Name of the component
Description Description of the MML component
Card Card that supports the interface
TDM Interface Properties dialog box
General tab
MML Name Name of the component
Description Description of the MML component
Card Card that supports the interface
Signal Type Signal type
Coding Line coding
Format Interface format
Details tab
Line Interface Number Line interface number
Resistance Resistance
Cisco Media Gateway Controller Node Manager User's Guide, 2.6(1)
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Table 8-7 Properties of Signaling Interface Components (continued)
Field Name Definition
Data Rate Data rate
Clock Clock
HDLC High-level data link control
DTE/DCE Data terminal equipment/Data communications equipment
Table 8-8 Properties of Signaling SS7 Components
Field Name Definition

SS7 Route Properties dialog box

MML Name Name of the component

Description Description of the MML component
Link Set Link set that leads to destination device
Priority Priority of the route

OPC Originating point code

DPC Destination point code

SS7 Subsystem Properties dialog box

MML Name Name of the component

Description Description of the MML component
Subsystem Number Subsystem number

Priority Priority of the route

Service Type of signaling service

Protocol Family Protocol used by the component
Transport Protocol Transport protocol

Mated APC Adjacent point code for an STP mate
STP/SCP Index STP/Service control point index
SuaKey MML name of SUAKEY

Local Subsystem Number |Local subsystem number (beginning in 9.5(2), used instead of
Subsystem number)

Remote Subsystem Remote subsystem number
Number
OPC Origination point code
SS7 Signaling Gateway Subsystem Properties dialog box
MML Name Name of the component
Description Description of the MML component
Subsystem Number Subsystem number
Priority Priority of the route
Protocol Family Protocol used by the component
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Table 8-8 Properties of Signaling SS7 Components (continued)

Field Name Definition
OPC Originating point code
APC Adjacent point code for an STP
STP/SCP Index STP/Service control point index
Signaling Gateway Pair Pair of SS7 signaling gateway nodes

Table 8-9 Properties of Signaling M3UA/SUA Components

Field Name Definition

M3UA Key Properties dialog box
MML Name Routing key name, alphanumeric string up to 20 characters.
Description Description of the MML component, up to 128 characters.
Service Indicator (Optional) Service indicator: ISUP,TUP,N/A. Default: N/A
Routing Context Routing context value, any integer except 0. Default: 0.
DPC (Optional) Destination point code
Network Appearance (Optional) Network appearance. 0-32767. 0 indicates an invalid

network appearance. Default: 0.

OPC (Required) Originating point code

M3UA Route Properties dialog box
MML Name M3UA route name, alphanumeric string up to 20 characters.
Description Description of the MML component, up to 128 characters.
DPC MML name of previously defined destination point code.
External Node MML name of a previously configured external node.
OPC MML name of a previously configured origination point code.

SUA Key Properties dialog box
MML Name Routing key name, alphanumeric string up to 20 characters.
Description Description of the MML component, up to 128 characters.
OPC (Required) Origination point code.
APC (Optional) Adjacent point code.
Local SSN Local subsystem number.
Routing Context Routing context value, any integer except 0. Default: 0.
Network Appearance (Optional) Network appearance. 0-32767. 0 indicates an invalid

network appearance. Default: 0.

SUA Route Properties dialog box
MML Name SUA route name, alphanumeric string up to 20 characters.
Description Description of the MML component, up to 128 characters.
APC MML name of previously defined adjacent point code.
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Table 8-9 Properties of Signaling M3UA/SUA Components (continued)
Field Name Definition
External Node MML name of a previously configured external node.
Remote SSN Remote subsystem number (destination).
OPC MML name of a previously configured origination point code.

Viewing Trunk Group Component Properties

You can view the properties of trunk group components of a Cisco MGC node such as:
¢ Configuration
e Status
e SIP attributes (Cisco MGC Release 9 and later)

Use the following procedure to view trunk group component properties:

Step1  In the Map Viewer, do one of the following:

e To view information for all trunk group components, select the Trunking folder, and right-click.
Choose Trunk Group Properties.

e To view information for a particular trunk group component, under the Trunking folder select the
desired component, and right-click. Choose Trunk Group Properties.

The dialog box displays information on the selected component’s properties. See the “About the
Trunk Group Properties Dialog Box™ section on page 8-44 for details.

Step2  (Optional) In the Properties dialog box, you can use the toolbar buttons or menu options to:
e Print the information on the current tab.
¢ Close the dialog box.
e Toggle dynamic update mode off and on.
e Refresh the window to update the information when dynamic update mode is off.

e Acknowledge that you have seen dynamically updated changes.

About the Trunk Group Properties Dialog Box

The Properties dialog box for trunk group components contains a toolbar and the fields described in
Table 8-10. By default, the Properties dialog is dynamically updated as device information changes. You
can use toolbar buttons to turn updating on or off, acknowledge that you have seen updated information,
and check for changes as desired when dynamic updating is off.

See the “Common Functionality in Properties Dialog Boxes” section on page 8-8 for more on dialog box
functionality.

Note  The trunk group properties you see, and the tabs they are located on, depend on the release of the
Cisco MGC software that you are using.

Cisco Media Gateway Controller Node Manager User's Guide, 2.6(1)
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Table 8-10 Properties of Trunk Group Components
Field Name Definition
General tab
Trunk Group Number Trunk group number.
Trunk Type Trunk transmission media.
Customer Group ID ID of the customer associated with the selected trunk group.
Priority Priority of the route.
Select Sequence Selection sequence.
Service Type of signaling service.
Queuable Whether the trunk group is capable of queuing calls.
Package Type CAS trunk group package.
Glare Call collision handling.
Default Presentation Number NOA |Sets the default for Presentation Number NOA value.
Default Presentation Number NPI |Sets the default for Presentation Number NPI value.
Default PN Enables the incoming trunk group to have default
presentation number if the incoming call does not have one;
overdecadic digits are supported.
Maximum ACL Maximum congestion level.
Number Plan Area The numbering plan area (NPA) code associated with the
incoming trunk group.
Carrier ID The carrier ID to which users on this trunk group are
associated.
Orig. Carrier ID Carrier ID digit string.
CLLI Common language location identifier.
Carrier Screening Whether to apply carrier selection and screening on the call.
Notify Setup Complete Whether to send notification when call setup completes.
Send Address to CGPN Determines if CLI digits should be sent in outgoing CgPN
parameter. Value is 0 (False) for don't include address digits
in CgPN param or 1 (True) for including address digits in
CgPN param; default is 1.
CGPN Presentation Restricted Determines if incoming Presentation Indication should be
overridden. Value is 0 (False) for leave as-is or 1 (True) for
set to presentation restricted; default is 0.
Enable IP Screening Enables the incoming trunk group to select dial plan based on
IP address, source ID and CLI prefix tables
Default PN Presentation Indicator |Sets default Presentation Number Presentation Indicator
value
Configuration tab
Fax/Modem Tone Specifies if notification of the fax/modem tone from the
MGOC is desired. Values are 0 (no) and 1 (yes).
Cisco Media Gateway Controller Node Manager User's Guide, 2.6(1)
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Table 8-10

Cisco Media Gateway Controller Node Manager User's Guide, 2.6(1)
8-46

Properties of Trunk Group Components (continued)

Field Name

Definition

Screen Fail Action

Indicates if an action is to be performed when a screening
failure occurs. Values and 0 (no) and 1 (yes).

Ring-No-Answer

Time (in seconds) that ringing can occur.

AOC Enabled

Whether advice of charge handling should be applied to this
call. Values and 0 (no) and 1 (yes).

Echo Cancel

Whether echo cancellation is required. Values and 0 (no) and
1 (yes).

ACC Control

ACC control procedure flag.

D Channel Status

Host controller-MIB accRespCatName.

External COT

External continuity test indicator.

Support 183 Response Code

Flag indicating support of 183 response code.

Customer VPN ID

Assigns a VPN customer name to the trunk group. Prefix="*"
Default="00000000, Size min=1 max=8.

VPN On-Net Table Number

Assigns VPN ON NET profile table indices for a particular
trunk group. Prefix="*" Default="0", Size min=1 max=8.

VPN Off-Net Table Number

Assigns VPN OFF NET profile table indices for a particular
trunk group. Prefix="*" Default="0", Size min=1 max=8.

Populate SDP Info in CDR

Enables extraction of information from SDP. 1 enables, 0
disables. Default 0.

Support 100 Response Code

Flag indicating support of 100 response code.

ACL Duration

Duration (in seconds) that ACL remains in effect.

Satellite

Indicates if the trunk group is going over a satellite. Values
and 0 (no) and 1 (yes).

Call Orig. Index

Starting number analysis digit index for call origination.

Call Term. Index

Starting number analysis digit index for call termination.

Transparency Disabled Indicates if ISDN User Part (ISUP) transparency is disabled.
Values 0 (no) and 1 (yes).
COT Percentage Statistical continuity test percentage.

Compression Type

The G.711 compression type used on the trunk.

From

The display name of the calling party.

Call Forward Reroute Disabled

Disables Call Forward rerouting for all calls. Prefix="%*.
Range 0 - 1. Default 0.

Feature Transparency Disabled

Disables Feature Transparency for all calls. Prefix="*. Range
0 - 1. Default 0.

OD 32 Digit Support

Indicates whether overdecadic and 32 digits are supported for
ANSI, Q721, Q761, and Q767 protocol variants. Values 0
(no) and 1 (yes). Default 0.

Status tab

Admin State

Administrative state of the component.

Locked

Number of bearer channels in LOCKED state.
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Table 8-10 Properties of Trunk Group Components (continued)
Field Name Definition
Unlocked Number of bearer channels in UNLOCKED state.
Shutdown Number of bearer channels in SHUTDOWN state.
SIP tab

Local Port UDP port for SIP communication.

VSC SIP Version Supported SIP version.

VSC Domain MGC domain name in SIP messages.

Max Redirection The maximum number of SIP message redirects allowed.

Max SIP Forward The maximum number of SIP forwards allowed.

T1 Timer T1 timer (in milliseconds) for SIP messages other than
INVITE messages.

INVITE Timer T1 timer for INVITE messages.

Orig. Session Timer The maximum session time (in milliseconds) for a SIP call
originated by the MGC.

Hold Timer Maximum hold time for a SIP call.

MIN Event Subscribe Duration Minimum duration for which an event can be subscribed, in
msec. Range: 40-3600 msec.

MAX Subscription Duration Maximum duration for which the subscription can exist
before it needs a re-subscription, in msec. Range: 0-3600
msec.

ISUP Trans Early Backward Sends the early backward message-183 session progress

Disabled without the SDP MIME body. O - Enable, 1 - Disable. Default
1.

SIP MIME Body Support Determines SIP-T and SIP-GTD related special processing of
data (used by SS7 and SIP trunk groups). O - None, 1- SIP-T
supported, 2 - SIP-GTD supported. Default 0.

MGC SIP Version The version of SIP protocol supported by MGC. Maps to
trunk group property MGCSipVersion. Any valid SIP
version, SIP2.0 default.

MGC Domain MGC's domain name used in SIP messages. Maps to trunk
group property MGCDomain. Any valid domain name or
NULL string.

Max SIP Forward The maximum number of SIP forward allowed. Maps to trunk
group property MaxForwards. Any value > 0, default 10.

T2 Timer T2 timer (in milliseconds) for SIP messages other than
INVITE messages.

EXPIRE Timer Timer value (in milliseconds) in the EXPIRE header of SIP
messages.

Term. Session Timer The maximum session time (in milliseconds) for a SIP call
terminated by the MGC.

Retry Timer The time (in milliseconds) that MGC waits before retrying
SIP calls.
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Table 8-10

Properties of Trunk Group Components (continued)

Field Name

Definition

GTD Cap Type

Used as a pointer to the subset of GTD configuration
parameters. Values: 0 - No GTD parameter string. Any other
string - points to entry in gtdParam.dat file. Default: 0.

Subscribe Notify Support

Enables or disables Unsolicited Notify method for solicited
notification of SIP DTMF digits.

GTD Message Format

Selects GTD message format. C - Compact mode, V - verbose
mode. Default C.

Unsolicited Notify Method

Enables or disables Subscribe/Notify method for solicited
notification of SIP DTMF digits.

SIP IP Source

Tells MDL to use IP packet source address or IP address from
SDP in INVITE message to do dial plan selection for SIP
calls.

Profile tab

Originating Line Information

Default originating line information.

Carrier Network 1D

Default carrier identifier network identifier.

Carrier Network Type

Default carrier identifier national network type.

Carrier Network ID Plan

Default carrier network national network identifier plan.

Charge Number

Default charge number.

Charge Number NOA Default charge number nature of address.
Charge Number NPI Default charge number plan identification.
Charge Origin Specifies the charge origin. It is up to the network engineer to

decide what value of charge origin will be used. Value is 0 to
9999; default is 0.

Directory Number Presentation

Default directory presentation indicator.

Directory Number Screening

Default directory screening indicator.

Directory Number

Default directory number.

Directory Number NOA

Default directory number nature of address.

Directory Number NPI

Default directory number plan identification.

H.323 Tab

Gateway Ring Back Tone

Indicates if the gateway ring back tone application is
supported within the gateway that hosts the trunk group and
the connection method that is applied.

Wait for Answer Timer

Duration, in seconds, that the MGC waits to receive the
Answer message after instructing the MGW to apply ring
back tone.

Wait for Originating SDP Timer

Duration, in seconds, that the MGC waits for the originating
SDP information after transiting the answer message.

Wait for Terminating SDP Time

Duration, in seconds, that the MGC waits for the terminating
SDP information after transiting the answer message.
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Table 8-10 Properties of Trunk Group Components (continued)
Field Name Definition
Allow H.323 Hairpin Whether to allow the HSI component connected through the

EISUP path to make and receive H.323 calls to and from
another HSI component.

Fax Support What fax support, if any, is available on the incoming trunk
group.
H.323 Adjunct Link Identifies an EISUP link that is connected to an H.323

adjunct platform.

Characteristics Tab

A Number National Prefix National prefix string to be added to the national dialed
number when NOA is enabled.

A Number International Prefix International prefix string to be added to the international
dialed number when NOA is enabled.

B Number National Prefix National prefix string to be added to the national dialed
number when NOA is enabled.

B Number International Prefix International prefix string to be added to the international
dialed number when NOA is enabled.

Apply Country Code to A Number |Whether to apply the country code to A numbers.

Apply Country Code to B Number |Whether to apply the country code to B numbers.

Country Code to be Removed Country code string to be removed.
Country Code to be Prefixed Country code string to be prepended.
A-number Normalization (European feature; ingress trunk groups) Indicates that

A-number (Calling Party Number) normalization is
appropriate based on the NOA value and the leading digits of
the A-number. Leading digits 0: Remove 0 and set NOA to
NATIONAL. 00: Remove 00 and set NOA to
INTERNATIONAL.

B-Number Normalization (European feature; ingress trunk groups) Indicates that
B-number (Called Party Number) normalization is
appropriate based on the NOA value and the leading digits of
the B-number. Leading digits 0: Remove 0 and set NOA to
NATIONAL. 00: Remove 00 and set NOA to

INTERNATIONAL.
SCP Credit Expired Timer Time period before credit expiry that the SCP is notified.
SSF Credit Expired Timer Time period before credit expiry that the SSF is notified.
Warning Credit Expired Timer Time period before credit expiry that a warning tone or

announcement is played.

Expiry Warning Tone Type Type of warning tone

Expiry Warning Tone Duration Duration of warning tone

CLI Select Whether the Dual CLI feature is supported (default is N).

GW Default Codec String Ordered series of codec choices, separated by semicolons.
More Tab
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Table 8-10

Properties of Trunk Group Components (continued)

Field Name

Definition

GW Default ATM Profile

Provides an initial list of profiles for use in ATM gateway
profiles negotiation per trunkgroup. Default “NULL”
type="string” size min="1" max="140"

Play Announcement

Contains announcement id. 0 means the functionality will be
considered as switched off at the trunk group level. Default
560?’ type:”int”

ATM Connection Type

Populates connection type indicator (ct:) in local connection
option parameters. This property is read for both originating
and terminating legs of all ATM switched calls. Property
Valid Values: 1-->AAL1,2--> AAL1_SDT, 3-->AAL1_UDT,
4-->AAL2, 5-->AAL 3/4, 6-->AALS. default="4"
type="int” range min="1" max="6"

B-number Tech Prefix

This property will provide a digit string to be used as a Tech
Prefix to the B-number when sending the call
forward.type="string” size min="1" max="16"

Loop Avoidance Support

This property will indicate whether to support Lop Avoidance
feature in DPNSS or not. Default 0 not supported, 1 -
supported.

Loop Avoidance Counter

Loop Avoidance counter for DPNSS. Min value is 0 and Max
25. default 0.

Country Code to be Removed

Country code string to be removed.

Country Code to be Prefixed

Country code string to be prepended.

MWI String OFF

MWI OFF string as used by DPNSS PBX, Default = NULL

MWI String ON

MWTI ON string as used by DPNSS PBX, Default = NULL

Inhibit Incoming Calling Name
Display

This property inhibit the support of incoming calling name
display in DPNSS and EISUP(HSI) protocols. “1” = inhibit
incoming calling name display. “0” = enable incoming
calling name display

Inhibit Outgoing Calling Name
Display

This property inhibit the support of outgoing calling name
display in DPNSS and EISUP HSI) protocols. “1” = inhibit
outgoing calling name display. “0” = enable outgoing calling
name display

Inhibit Incoming Connected
Number Display

This property inhibit the support of the incoming connected
name display for call transfer in DPNSS and EISUP (HSI)
protocols. “1” = inhibit incoming connected name display.
“0” = enable incoming connected name display

AOC Default Tariff Id

This property is used to configure the default tariff to be
applied when AOCInvokeType is configured as “All Calls”.
Min = “1”, max = “9999”. Default = “1”

AOC Invoke Type

This property is used to configure whether the AOC
Supplementary services should be applicable for all calls or
for per call basis. (“1” = per call, “2” = All calls). Default =
561?’
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Using Diagnostic Tools

Properties of Trunk Group Components (continued)

Field Name Definition

Mid-Call Check Pointing Interval |a property to allow user to enable/disable mid-call
checkpointing and when enabled, it specifies the interval
between checkpointing event in the connected state. min = 0,
max=60(in minute unit). value zero means disabled

CLI Selection For Code Of A new PGW2200 Trunk Group Property called

Practice3 “CliSelectionForCodeOfPractice3” will be introduced in
order to provision “per Trunk Group” which level of CLI
selection should be employed when sending the Calling Line
Identities (such as Calling Party Number or Generic Number
parameter) to the succeeding exchange. O - Indicates no
specific CLI selection. 1 - Indicates Single CLI selection 2
- Indicates Dual (double) CLI selection Property Valid
Values: 0 to 2 Property Default Value: 0

Inhibit Outgoing Connected Name |This property inhibit the support of the outgoing connected
Display name display for call transfer in DPNSS and EISUP (HSI)
protocols. “1” = inhibit outgoing connected name display.
“0” = enable outgoing connected name display

Inhibit Outgoing Connected This property inhibit the support of the outgoing connected
Number Display number display for call transfer in DPNSS and EISUP (HSI)
protocols. “1” = inhibit outgoing connected number display.
“0” = enable outgoing connected number display.

Using Diagnostic Tools

Note

When you need to troubleshoot Cisco MGC node devices, you can use the Diagnostics dialog box to
access a variety of diagnostic tools. The Diagnostics dialog box provides shortcuts for common
diagnostics that normally require using UNIX or MML commands. For example, you can use the ping
application to determine if a device is not responding because of an SNMP agent failure or a true network
connectivity failure.

After the command is run, you see the results in the Action Result window. If the diagnostic command
generates more information than can be shown in the Action Result window, the results are written to a
file and you see the name of that file. The file can be retrieved and analyzed by external systems.

Many diagnostic commands are time consuming to run. Take this into account when planning your use
of diagnostic tools.

Related Topics

The “Using Cisco MGC Node Manager To Launch Device Configuration” section on page 8-4 describes
how to use various configuration and diagnostic tools such as Cisco VSPT, Cisco View, and launching
Telnet (or ssh) or X-windows to a device.

The “Using the Cisco MGC Toolbar” section on page 8-54 describes how to use the Cisco MGC Toolbar,
a diagnostic component of the Cisco MGC software.

Use the following procedure to run diagnostics on a Cisco MGC node device:

[ oL-9110-01
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Step 1

Step 2

Step 3

Step 4

Step 5

In the Map Viewer, select the desired device and right-click.

~

Note  Alternatively, if you have an Accounts, Properties, States, or File Systems dialog box open for
the device, you can use the dialog box Navigation menu to open the Diagnostics dialog box.

Choose [Device Name] Diagnostics or Tools > [Device Name] Diagnostics. The Diagnostics dialog
box for the selected device appears.

S

Note  You can use the Navigation menu to open the Properties, File Systems (where applicable),
Accounts, or States dialog box for the selected component.

Select the desired diagnostic option. For details, see the “About the Diagnostics Dialog Box” section on
page 8-52.

You are asked to confirm the operation.
Click Yes to confirm or No if you decide not to continue.

An Action Report box appears containing the results of the diagnostic operation or the name of the file
to which the results have been saved.

Review the results, then click Close to close the Action Report box.

About the Diagnostics Dialog Box

The Diagnostics dialog box lets you run common UNIX and MML diagnostic commands from
Cisco MGC Node Manager without knowing any UNIX or MML or having to launch an X window to
connect to the device.

For the Cisco MGC host and the HSI host, the dialog box contains two tabs, the Diagnostics tab and the
Advanced tab, which provides status check functions. For all other devices, the dialog box contains the
Diagnostics options only.

The Diagnostics dialog box includes a Navigation menu that allows navigating directly to Properties,
Accounts, File Systems (where applicable), or States dialog boxes for the selected component, without
having to reselect the component in the Map Viewer. See Chapter 3, “Getting Started with Cisco MGC
Node Manager,” “Navigating between Dialog Boxes for a Given Component” on page 32 for details.

Table 8-11 describes the diagnostic tools available from the Diagnostics dialog box General tab.

Table 8-12 describes the tools available for the Cisco MGC host from its Diagnostics dialog box
Advanced tab. Table 8-13 describes the tools available for the HSI host from its Diagnostics dialog box
Advanced tab.

Cisco Media Gateway Controller Node Manager User's Guide, 2.6(1)
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Table 8-11 Diagnostics Dialog Box General Tab
Diagnostic Tool |Command Available Devices |Description
IP Ping Cisco MGC host, Performs standard UNIX ping application on
BAMS, Cisco SLT, |the. device to see if its management interface
Cisco LAN Switch |is reachable
SNMP Ping All IP devices Makes an SNMP request to the device to
determine if its SNMP agent is running and
accessible
Traceroute All IP devices Determines the route that packets take from
Cisco MGC Node Manager to the device’s
management interface
Alarm Log rtrv-alms Cisco MGC host, Displays and saves current alarm log
HSI server, and information
BAMS
Process Status rtrv-softw:all |Cisco MGC host, Displays and saves current status of all device
HSI server, and processes
BAMS
System Log RTRV-FILE |BAMS Displays the BAMS system log
S::
/acec/files/sy
slog
Cross-Device prov-rtrv:itru  |[BAMS Audits BAMS trunk groups against the
Audit nkgrp Cisco MGC host configuration, producing a
list of discrepancies, if any
Table 8-12 Cisco MGC Diagnostics Dialog Box Advanced Tab
Option |MML Command’ Description
1 rtrv-admin-state Retrieves the administrative state for all (applicable) components
2 rtrv-dest Retrieves state information for all DPCs? and signaling paths
3 rtrv-Ink-ctr Retrieves the service state of all linksets
4 rtrv-1ssn Retrieves the state of all local SSNs
5 rtrv-ne-health Retrieves CPU occupancy and disk utilization
6 rtrv-rssn Retrieves the state of all remote SSNs®
7 rtrv-rte Retrieves the SS7 routes for all point codes.
8 rtrv-sc Retrieves the state of all signaling channels and linksets
9 rtrv-tc Retrieves the state of bearers for all signaling paths
1. The MML command invoked by the Status Check option; runs in the background
2. Destination point codes
3. Subsystem numbers
Cisco Media Gateway Controller Node Manager User's Guide, 2.6(1)
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Table 8-13

HSI Host Diagnostics Dialog Box, Advanced Tab (HSI 2.21)

Option Description

Configuration Displays current configuration of the HSI host using the
rtrv-config command

HSI Link Status Displays current status of the IP/EISUP links

HSI Host Status Displays current status of the HSI host

Using the Cisco MGC Toolbar

From Cisco MGC Node Manager, you can access the Cisco MGC toolbar (see Figure 8-2), a standalone
diagnostic component of the Cisco MGC software. The toolbar contains a suite of tools for viewing
diagnostic and troubleshooting information.

Figure 8-2 Cisco MGC Toolbar
0 MGC Toolbar M=l E
Alanm&Meas CDR CONFIG-LIB Log Trace | Translation File dose |2
Viewer Viewer Viewer Viewer Viewer Vetification Options o
=t

From the MGC Toolbar you can access these viewers:
e Alarm and Measurement Viewer—Search and view alarms and system statistics
e (Call Detail Record (CDR) Viewer—Search and view call detail records (CDRs)
¢ CONFIG-LIB Viewer—Manage the contents of the configuration library
e Log Viewer—Search and view system logs
e Trace Viewer—View and navigate through call trace output
e Translation Verification—View called number analysis results
¢ File Options—A tool to manage these toolkit files

Instructions for using the toolbar are provided in the Cisco MGC documentation under “Using the
Cisco MGC Viewer Toolkit,” which can be found in the Operations, Maintenance, and Troubleshooting
Guide at
http://www.cisco.com/en/US/products/sw/voicesw/ps1913/products_maintenance_guide_chapter09186
a008007e58f.html#wp1043288.
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